Where the 'Vrsn' column shows <9>.", the command is only supported in Word 2000 and above
Most - but NOT all - of the shortcuts are language-independent. In particular, most of the Alt menu shortcuts are NOT;

but you can find out the Alt menu shortcut in your
language by looking at which letters are underlined on the relevant menus.

Word Command Description Version Menu Shortcut
AllCaps Makes the selection all capitals (toggle) Ctrl + Shift + A
ApplyHeadingl Applies Heading 1 style to the selected text Alt+ Ctrl +1
ApplyHeading2 Applies Heading 2 style to the selected text Alt+ Ctrl +2
ApplyHeading3 Applies Heading 3 style to the selected text Alt+ Ctrl +3
ApplyListBullet Applies List Bullet style to the selected text Ctrl + Shift + L
AppMaximize Enlarges the application window to full size Alt + F10
AppRestore Restores the application window to normal size Alt + F5
Bold Makes the selection bold (toggle) Formatting toolbar Ctrl+B
BrowseNext Jump to the next browse object Double-down-arrow Ctrl + PgDn
below vertical scrollbar
BrowsePrev Jump to the previous browse object Double-up-arrow below |Ctrl + PgUp
vertical scrollbar
BrowseSel Select the next/ prev browse object Alt + Ctrl + Home
Cancel Terminates an action Esc
CenterPara Centers the paragraph between the indents Formatting toolbar Ctrl+E
ChangeCase Changes the case of the letters in the selection Shift+F3
CharLeft Moves the insertion point to the left one character Left arrow
CharLeftExtend Extends the selection to the left one character Shift + Left arrow
CharRight Moves the insertion point to the right one character Rt arrow
CharRightExtend Extends the selection to the right one character Shift + Rt arrow
ClosePane Closes the active window pane (if you are in Normal View and Close button on the Alt + Shift + C
have, for example, the Footnote pane open) relevant panes
ColumnSelect Selects a columnar block of text Alt+Drag (or press Ctrl +
Shift + F8 and drag, but Alt
+ Drag is far easier!)
CopyFormat Copies the formatting of the selection Ctrl +Shift+C
CopyText Makes a copy of the selection without using the clipboard (press Shift + F2
Return to paste)
CreateAutoText Adds an AutoText entry to the active template Alt + F3




Word Command

Shortcut

Description

DeleteBackWord Deletes the previous word without putting it on the Clipboard Ctrl+ Backspace
DeleteWord Deletes the next word without putting it on the Clipboard Ctrl + Del
DocClose Prompts to save the document and then closes the active window. Ctrl+W, Ctrl+F4
(But doesn’t intercept the menu command)

DocMaximize Enlarges the active window to full size Ctrl + F10
DocMove Changes the position of the active window Ctrl + F7
DocRestore Restores the window to normal size Ctrl + F5
DocSize Changes the size of the active window Ctrl + F8
DocSplit Splits the active window horizontally and then adjusts the split Window menu Alt+Ctrl +S
DoFieldClick Executes the action associated with macrobutton fields Alt + Shift + F9
DoubleUnderline Double underlines the selection (toggle) Word 2000 Extended Ctrl + Shift + D

Formatting toolbar
DrawGroup Groups the selected drawing objects Draw menu AltR, G
DrawNudgeDown Moves the selected drawing objects down Down arrow
DrawNudgeLeft Moves the selected drawing objects to the left Left arrow
DrawNudgeRight Moves the selected drawing objects to the right Right arrow
DrawNudgeUp Moves the selected drawing objects up Up arrow
DrawSnapToGrid Sets up a grid for aligning drawing objects Draw menu AltR, 1
DrawUngroup Ungroups the selected group of drawing objects Draw menu AltR, U
EditBookmark Brings up the bookmark dialog Insert menu Ctrl+Shift+F5 (Or: Alt I, K)
EditClear Performs a forward delete or removes the selection without putting Edit menu Del

it on the Clipboard

EditCopy Copies the selection and puts it on the Clipboard Edit menu & Standard Ctrl+C

toolbar
EditCut Cuts the selection and puts it on the Clipboard Edit menu & Standard Ctrl+X

toolbar
EditFind Finds the specified text or the specified formatting Edit menu Ctrl+F
EditGoTo Jumps to a specified place in the active document Edit menu F5, Ctrl+G
EditLinks Allows links to be viewed, updated, opened, or removed Edit menu AltE, K
EditPaste Inserts the Clipboard contents at the insertion point Edit menu & Standard Ctrl+V

toolbar
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Version

Shortcut

Description

EditPasteSpecial Inserts the Clipboard contents as a linked object, embedded object, Edit menu AItE, S
or other format
EditRedo Redoes the last action that was undone Standard toolbar Alt + Shift + Backspc
EditRedoOrRepeat Repeats the last command, or redoes the last action that was Edit menu F4
undone (unfortunately, doesn’t work for as many commands in
Word 2000 as in Word 97 and below, but this is still one of Word’s
most useful shortcuts, if not the most useful)
EditReplace Finds the specified text or the specified formatting and replaces it Edit menu Ctrl+H
EditSelectAll Selects the entire document Edit menu Ctrl+A
EditUndo Reverses the last action Edit menu & Standard Ctrl+Z
toolbar
EndOfColumn Moves to the last cell in the current table column Alt + PageDn (to select to
end of column, use Alt +
Shift + PgDn)
EndOfDocExtend Extends the selection to the end of the last line of the document Ctrl+Shift+End
EndOfDocument Moves the insertion point to the end of the last line of the document Ctrl+End
EndOfLine Moves the insertion point to the end of the current line End
EndOfLineExtend Extends the selection to the end of the current line Shift+End
EndOfRow Moves to the last cell in the current row Alt+End
EndOfWindow Moves the insertion point to the end of the last visible line on the Alt + Ctr] + PgDn
screen
EndOfWindowExtend Extends the selection to the end of the last visible line on the screen Shift + Alt + Ctrl + PgDn
ExtendSelection Turns on extend selection mode and then expands the selection Status bar (double-click) |F8 (press Esc to turn off)
with the direction keys
FileCloseOrExit Closes the current document, or if no documents are open, quits <9> Alt + F4 (<9>)
Word. Horrible command, as it makes it a long winded business to
quit Word. But there’s a simple solution - assign Alt+F4 to FileExit
instead.




Word Command

Description

Shortcut

FileExit Quits Microsoft Word and prompts to save the documents (does File menu Alt + F4 (Word 97)

intercept the menu item, but not the keyboard shortcut, or the x

button. An AutoExit macro is usually a better way of intercepting

this).
FileNew Creates a new document or template (brings up the dialog). Note File menu (but not std NOT Ctrl+N!!

that: Word pretends that Ctrl+N is assigned to FileNew but it isn’t, toolbar)

it's assigned to FileNewDefault You can fix this in Word 2000 by

assigning Ctrl+N to the FileNewDialog command. In Word 97 the

only way to fix it is to create a macro called FileNew (to do this,

press Alt + F8, type "FileNew" without the quotes and Click

"Create". The macro will automatically contain the code needed to

make it work).
FileNewDefault Creates a new document based on the Normal template. Std toolbar Ctrl+N
FileOpen Opens an existing document or template File menu & std toolbar  |Ctrl+O
FilePageSetup Changes the page setup of the selected sections File menu AltF, U
FilePrint Prints the active document (brings up the dialog) File menu Ctrl + P
FilePrintPreview Displays full pages as they will be printed File menu & std toolbar | Ctrl+F2
FileProperties Shows the properties of the active document File menu AltF 1
FileSave FileSave File menu, std toolbar Ctrl+S
FileSaveAs Saves a copy of the document in a separate file (brings up the File menu AltF, A (or F12)

dialog)
Font Activates the Fonts listbox on the formatting toolbar Formatting toolbar Ctrl+Shift+F
FontSizeSelect Activates the Font Size drop-down on the formatting toolbar Formatting toolbar Ctrl+Shift+P
FormatAutoFormat Automatically formats a document (or sometimes, automatically Format menu Alt+Ctrl + K

screws it up)
FormatBordersAndShading Changes the borders and shading of the selected paragraphs, table Format menu AltO, B

cells, and pictures
FormatChangeCase Changes the case of the letters in the selection Format menu AltO,E
FormatColumns Changes the column format of the selected sections (brings up the Format menu AltO, C

dialog)
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FormatDropCap Formats the first character of current paragraph as a dropped Format menu AltO,D

capital (must select it first)
FormatFont Brings up the Format + Font dialog Format menu Ctrl+D
FormatHeaderFooterLink Links the current header/footer to the previous section (but does Alt + Shift + R

not intercept the button on the Header Footer toolbar)
FormatParagraph Brings up the Format Paragraph dialog Format menu AltO, P
FormatStyle Applies, creates, or modifies styles Format menu AltO,S
FormatTabs Brings up the Format Tabs dialog Format menu AltO, T
GoBack Returns to the previous insertion point (goes back to up to 3 points, Shift + F5

then returns to where you started; this is one of the most useful

shortcuts of them all. Also useful when opening a document, if you

want to g straight to where you were last editing it)
GrowFont Increases the font size of the selection Ctrl + >
GrowFontOnePoint Increases the font size of the selection by one point Ctrl +]
HangingIndent Increases the hanging indent Ctrl + T (or drag the ruler)
Help Microsoft Word Help Help menu F1
HelpTool Lets you get help on a command or screen region or examine text Shift + F1

properties
Hidden Makes the selection hidden text (toggle) Ctrl + Shift + H
HyperlinkOpen Connect to a hyperlink’s address Click on it
Indent Moves the left indent to the next tab stop Ctrl + M (or drag the ruler)
InsertAnnotation Inserts a comment Insert menu Alt + Ctrl + M (or Alt I, M)
InsertAutoText Replaces the name of the AutoText entry with its contents F3
InsertBreak Ends a page, column, or section at the insertion point Insert menu AltI, B
InsertCaption Inserts a caption above or below a selected object Insert menu Altl, C
InsertColumnBreak Inserts a column break at the insertion point Ctrl + Shift + Return
InsertDateField Inserts a date field Alt + Shift + D
InsertEndnoteNow Inserts an endnote reference at the insertion point without Alt+ Ctrl + D

displaying the dialog
InsertField Inserts a field in the active document Insert menu AltLF
InsertFieldChars Inserts an empty field with the enclosing field characters Ctrl+F9




Word Command

Description

Shortcut

InsertFile Inserts the text of another file into the active document Insert menu AltI, L
InsertFootnote Inserts a footnote or endnote reference at the insertion point Insert menu AltN
InsertFootnoteNow Inserts a footnote reference at the insertion point without displaying Alt+ Ctrl + F
the dialog
InsertHyperlink Insert Hyperlink Insert menu Ctrl + K
InsertindexAndTables Inserts an index or a table of contents, figures, or authorities into the Insert menu AltI, D
document
InsertListNumField Inserts a ListNum Field Alt+Ctrl + L
InsertMergeField Brings up a dialog to insert a mail merge field at the insertion point. Alt + Shift + F
(It does not intercept the button on the Mail merge. toolbar)
InsertPageBreak Inserts a page break at the insertion point Ctrl + Return
InsertPageField Inserts a page number field HeaderFooter toolbar Alt + Shift + P
InsertSpike Empties the spike AutoText entry and inserts all of its contents into Ctrl + Shift + F3
the document
InsertTimeField Inserts a time field Alt + Shift + T
Italic Makes the selection italic (toggle) Formatting toolbar Ctrl +1
JustifyPara Aligns the paragraph at both the left and the right indent Formatting toolbar Ctrl +]
LeftPara Aligns the paragraph at the left indent Formatting toolbar Ctrl +L
LineDown Moves the insertion point down one line Down arrow
LineDownExtend Extends the selection down one line Shift + down arrow
LineUp Moves the insertion point up one line Up arrow
LineUpExtend Extends the selection up one line Shift + up arrow
LockFields Locks the selected fields to prevent updating Ctrl + F11
MailMergeCheck Checks for errors in a mail merge Alt + Shift + K
MailMergeEditDataSource Lets you edit a mail merge data source Mail merge toolbar Alt+Shift+E
MailMergeToDoc Collects the results of the mail merge in a document Mail merge toolbar Alt + Shift + N
MailMergeToPrinter Sends the results of the mail merge to the printer Mail merge toolbar Alt Shift + M
MarkCitation Marks the text you want to include in the table of authorities Alt + Shift + 1
MarkIndexEntry Marks the text you want to include in the index Alt + Shift + X
MarkTableOfContentsEntry Inserts a TC field (but it is far better to use Heading Styles to Alt + Shift + O
generate your Table of Contents instead)
MenuMode Makes the menu bar active Alt or F10
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MicrosoftScriptEditor Starts or switches to Microsoft Development Environment <9> Alt + Shift + F11
application, allowing you to view the HTML/ XML source code that
would be behind the document if it were in .htm format (or that is
behind it if it already is in .htm format).
MicrosoftSystemInfo Execute the Microsoft System Info application Alt + Ctrl + F1
MoveText Moves the selection to a specified location without using the F2
clipboard (press Return to execute the more)
NextCell Moves to the next table cell Tab
NextField Moves to the next field F11
NextMisspelling Find next spelling error Alt + F7
NextObject Moves to the next object on the page Alt + down arrow
NextWindow Switches to the next document window, equivalent to selecting a Ctrl + F6
document from the Window menu.
NormalStyle Applies the Normal style Ctrl+Shift+N
OpenOrCloseUpPara Sets or removes extra spacing above the selected paragraph Ctrl +0
OtherPane Switches to another window pane in Normal View (for instance, if Fo6
you have if you have a Footnotes pane open in Normal view and
want to switch to the main document and back without closing the
pane).
OutlineCollapse Collapses an Outline in Outline View by one level Outlining toolbar Alt+_
OutlineDemote Demotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+rt arrow
OutlineExpand Expands an Outline in Outline View by one level Outlining toolbar Alt++
OutlineMoveDown Moves the selection below the next item in the outline Outlining toolbar Alt+Shift+down arrow
OutlineMoveUp Moves the selection above the previous item in the outline Outlining toolbar Alt+Shift+up arrow
OutlinePromote Promotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+left arrow
OutlineShowFirstLine Toggles between showing the first line of each paragraph only or Outlining toolbar Alt + Shift + L
showing all of the body text in the outline
Overtype Toggles the typing mode between replacing and inserting Ins
PageDown Moves the insertion point and document display to the next screen PgDn
of text
PageDownExtend Extends the selection and changes the document display to the next Shift+ PgDn
screen of text
PageUp Moves the insertion point and document display to the previous PgUp
screen of text
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PageUpExtend Extends the selection and changes the document display to the Shift + PgUp
previous screen of text
ParaDown Moves the insertion point to the beginning of the next paragraph Ctrl + down arrow
ParaDownExtend Extends the selection to the beginning of the next paragraph Shift + Ctrl + down arrow
ParaUp Moves the insertion point to the beginning of the previous Ctrl + up arrow
paragraph
ParaUpExtend Extends the selection to the beginning of the previous paragraph Shift + Ctrl + up arrow
PasteFormat Applies the previously copied formatting to selection Ctrl+Shift+V
PrevCell Moves to the previous table cell Shift + Tab
PrevField Moves to the previous field Shift + F11
PrevObject Moves to the previous object on the page Alt + up arrow
PrevWindow Switches back to the previous document window Ctrl + Shift + F6
RepeatFind Repeats Go To or Find to find the next occurrence Sfift+F4
ResetChar Makes the selection the default character format of the applied style Ctrl+Spacebar
ResetPara Makes the selection the default paragraph format of the applied Ctrl+Q
style
RightPara Aligns the paragraph at the right indent Formatting toolbar Ctrl +R
ShowAll Shows/hides all nonprinting characters Standard toolbar Ctrl +*
ShowAllHeadings Displays all of the heading levels and the body text in Outline View Outlining toolbar Alt + Shift + A
ShrinkFont Decreases the font size of the selection Ctrl + <
ShrinkFontOnePoint Decreases the font size of the selection by one point Ctrl + [
SmallCaps Makes the selection small capitals (toggle) Ctrl + Shift + K
SpaceParal Sets the line spacing to single space Ctrl +1
SpaceParal5 Sets the line spacing to one-and-one-half space Ctrl +5
SpacePara2 Sets the line spacing to double space Ctrl +2
Spike Deletes the selection and adds it to the “Spike” AutoText entry Ctrl + F3
(which allows you to move text and graphics from nonadjacent
locations)
StartOfColumn Moves to the first cell in the current column Alt + PgUp
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StartOfDocExtend Extends the selection to the beginning of the first line of the Ctrl+Shift+Home
document
StartOfDocument Moves the insertion point to the beginning of the first line of the Ctrl +Home
document
StartOfLine Moves the insertion point to the beginning of the current line Home
StartOfLineExtend Extends the selection to the beginning of the current line Shift+Home
StartOfRow Moves to the first cell in the current row Alt+Home
StartOfWindow Moves the insertion point to the beginning of the first visible line on Alt+Ctrl+PgUp
the screen
StartOfWindowExtend Extends the selection to the beginning of the first visible line on the Shift+ Alt+Ctrl+PgUp
screen
Style Activates the Style drop-down on the Formatting toolbar Strl + Shift + S
Subscript Makes the selection subscript (toggle) Ctrl + =
Superscript Makes the selection superscript (toggle) Ctrl + +
SymbolFont Applies the Symbol font to the selection Ctrl + Shift + Q
TableAutoFormat Applies a set of formatting to a table Table menu, Tablesand |Alt A, F
Borders toolbar
TableHeadings Toggles table headings attribute on and off Table menu Alt A, H
TableSelectColumn Selects the current column in a table Table menu Alt + click (Alt + drag to
select several)
TableSelectRow Selects the current row in a table Table menu Click in left margin
TableSelectTable Selects an entire table Table menu Alt + double-click
TableUpdateAutoFormat Updates the table formatting to match the applied Table Alt+ Ctrl + U
Autoformat settings
ToggleFieldDisplay Shows the field codes or the results for the selection (toggle) Rt-click menu Shift + F9 (Alt + F9 toggles
all field codes on or off)
ToolsCustomize Allows you to customizes the Word user interface (menus, Tools menu Alt T, C
keyboard and toolbars) and store the customizations in a template
(defaults to Normal.dot, so be careful!)
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ToolsCustomizeAddMenuShortcut

Allows you to copy an item from a toolbar to the main menu, or to
copy a nested menu item to its main menu. However, it works with
some buttons and not others, and it does not give you any control
over where the item gets added (that's all "taken care of" for you by
Microsoft). Using Tools + Customise works much better. But for the
record, an example of the former is: press Alt+Ctrl+=, then click on
the "Insert Microsoft Excel Worksheet" menu on the standard
toolbar. You'll find that the button has now been added to the Insert
menu. An example of the latter: press Alt+Ctrl+= and click on Insert
+ Picture + From File. The button gets inserted (without being
nested) on the main Insert menu. But you can do this far more
straightforwardly and with much more control if you use Tools +
Customize instead.

Alt+ Ctrl + =

(The equals sign on the
main keyboard, not the one
on the numeric keypad)

ToolsCustomizeRemoveMenuShortcut

Allows you to delete a menu sub-item without having to use the
Customize dialog.Does not wirh toolbar buttons (you can use Alt- +
drag to remove those). Press Alt+Ctrl+Hyphen, and the mouse
cursor changes to a thick black bar. Pull down a menu and click on
the item you want to remove. But be extremely careful - it's easy to
remove the wrong thing by mistake! The main reason it can be
useful is that it's the only way to remove an individual item from
the Most Recently Used Files list without resorting to a macro. But
the macro-based solution for that is much easier - see:
www.mvps.org/word/FAQs/Customization/ OpenMostRecentlyU
sed.htm for details

Alt+ Ctrl +-

(The hyphen on the main
keyboard, not the one on the
numeric keypad)

ToolsMacro Runs, creates, deletes, or revises a macro Tools menu (Macro + Alt + F8

Macros)
ToolsProofing Checks the spelling and grammar in the active document Tools menu F7
ToolsRevisionMarksToggle Toggles track changes for the active document Ctr.] + Shift + E
ToolsThesaurus Finds a synonym for the selected word Tools menu (under Shift + F7

Language)
Underline Formats the selection with a continuous underline (toggle) Formatting toolbar Ctrl+U
UnHang Decreases the hanging indent Ctrl + Shift + T (or drag the

ruler)
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UnIndent Moves the left indent to the previous tab stop Ctrl + Shift + M (or drag the
ruler)
UnlinkFields Permanently replaces the field codes with the results Ctrl+Shift+F9
UnlockFields Unlocks the selected fields for updating Ctrl + Shift + F11
UpdateFields Updates and displays the results of the selected fields F9
UpdateSource Copies the modified text of a linked file back to its source file Ctrl + Shiift + F7
ViewAnnotations Show or hide the comment pane View menu (View + Hover over comment
Comments)
ViewEndnoteArea If in Normal View, opens a pane for viewing and editing the Dbl-click the endnote
endnote (toggle). If in Page/Print Layout View, switches from the reference
body text to the endnote or vice versa
ViewFieldCodes Shows the field codes or results for all fields (toggle) At+F9
ViewFootnoteArea If in Normal View, opens a pane for viewing and editing the Dbl-click the footnote
footnote (toggle). If in Page/Print Layout View, switches from the reference
body text to the footnote or vice versa.
ViewFootnotes If in Normal View, opens a pane for viewing and editing footnotes View menu AltV,F
and endnotes (toggle). If in Page/Print Layout View, switches from
the body text to the footnotes/endnotes or vice versa.
ViewHeader Displays header in page layout view View menu AltV, H
ViewNormal Changes the editing view to normal view View menu AltV, N (or Alt + Ctrl + N)
ViewOutline Displays a document's outline View menu AltV, O (or Alt + Ctrl + O)
ViewPage Displays the page more-or-less as it will be printed, and allows View menu AltV, P (or Alt + Ctrl + P)
editing (In Word 2000 the menu item is called Print Layout, but
fortunately the command hasn’t changed.
ViewVBCode Shows the VB editing environment (Tools + Macro + Visual Basic Tools menu Alt + F11
Editor)
WebGoBack Backward hyperlink (useful if you clicked on a page number Web toolbar Alt + left arrow
hyperlink in the table of contents and then want to return to the
TOCQ)
WebGoForward Forward hyperlink Web toolbar Alt + rt arrow
WindowArrangeAll Arranges windows as non-overlapping tiles Window menu AltW, A
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WordLeft Moves the insertion point to the left one word Ctrl + left arrow
WordLeftExtend Extends the selection to the left one word Shift + Ctrl + left arrow
WordRight Moves the insertion point to the right one word Ctrl + rt arrow
WordRightExtend Extends the selection to the right one word Shift + Ctrl + rt arrow
WordUnderline Underlines the words but not the spaces in the selection (toggle) Ctrl + Shift + W




